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① ソフトウェアのインストール 

●インストールするパソコンの主なシステム条件 

Windows 8 Pro/Enterprise 64 bit、Windows 8.1 Pro/Enterprise 64 bit 

Windows 10 Pro/Enterprise 64 bit 

Intel® Core™ 2 Duo 2.00 GHz （Intel® Core™ i5 以上を推奨） 

RAM 4GB 以上 

ＨＤＤもしくはＳＳＤの空容量 800MB 

AirMagnet サポートの無線ネットワーク・アダプタ 

 詳細は https://www.netally.com/ でご確認下さい。 

● 図面の読込可能フォーマット 

.jpg .png .bmp .gif .dib .dwf .dwg .dxf .emf .vsd .wmf .vdx 

 

ソフトウェアのインストール、起動、使用を開始する前には以下の点にご注意ください。 

・最新バージョンの Survey PRO インストールする前に、コントロールパネルを使用して以前のバージョンの

AirMagnet サーベイをアンインストールする必要があります。 

「Repair」機能は使用しないでください。「Repair」を使用すると、一部のバージョンの Windows で信頼性 

の低いパフォーマンスが発生します。 

・インストールの際には必要なプログラム等をインターネットから取得する場合があるため、インターネット接続を

有効にしてください。 

・ソフトウェアを実行するには管理者権限を持つユーザーアカウントが必要です。 

・PC や OS により表示される画面・インストールされる物が異なる場合があります。 

・特定のセキュリティ設定やウィルス対策ソフトがソフトウェアの動作の妨げになる場合があります。 

・無線アダプターを使用するその他のソフトウェアは本ソフトウェアと競合する場合があります。 
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●ソフトウェアの準備

My AirMagnet  https://airmagnet.netally.com/my_airmagnet/ からダウンロードした 最新の USB ドライバー 

ファイルとインストールファイル、ライセンスファイルを用意します。ダウンロードに際して

サポートサービスのご契約が必要となります。本書巻末の「④サポートサービスについて」をご参照ください。

以下、EDIMAX AC1750-JP アダプターをご使用になる事を前提に説明します。 

  USB ドライバーファイル        インストールファイル ライセンスファイル

上記のファイル名は異なる場合もあります。最新版をお使いください。 

ダウンロードの方法は「My_AirMagnet のご案内」をご参照ください。 

お手元にない場合は弊社へご連絡ください。 

●ドライバーのインストール

ダウンロードしたドライバーファイルを起動し、インストールします。 

PC の設定により表示される画面が異なる場合がございます。 

ドライバーファイルをダブルクリックします。 

Extract をクリックします。 
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インストールが終了すると PC の再起動を求められますので再起動をします。

以上の手順でドライバーのインストールは終了です。
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●Survey-PRO のインストール

ファイル名のバージョンは異なる場合もあります。最新版をお使いください。

最新版の入手方法はhttp://www.keisokuki-land.co.jp/support/netally より「My_AirMagnet のご案内」をご参照ください。 

MAC リセット後など、同じパソコンに再インストールする場合 

ライセンスファイルも含めてアンインストールしてから再インストールを実行してください。

この際、ドライバーも最新版を再インストールしてください。 

ライセンスファイルはデフォルトでは "C:\Program Files(x86)\AirMagnet Inc\AirMagnet Surveyor"

にインストールされます。ファイル名は"A4018-12345678.lic"のように表示されます。(12345678 の部分

はシリアルナンバーが入ります。) 新たなライセンスファイルの入手方法については製品ご購入の際に 

お届けしている「My_AirMagnet のご案内」をご参照ください。 

USB アダプターはまだパソコンに接続しないでください。 

ダウンロードしたインストールファイルを実行します。 
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※パソコンにインストールされているドライバーやモジュールの状況により説明の手順と異なる場合があります。



日本語クイックガイド AirMagnet Survey-PRO Ver.10.0.0  ℂTOYO KEISOKUKI 2020 Aug. 

11 

この後、パソコンの再起動を要求される場合もあります。 

その際は他のアプリケーションが開いている場合は終了して頂き必要なファイルは保存してください。 

Windows メニューに AirMagnet Survey フォルダーが作成され、その中に Survey-PRO 項目が作成されます。 

ヘルプファイルを参照できます。

  "Survey PRO"を実行します。 
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●ライセンスファイルの指定

ソフトウェア起動前に MAC アドレスを登録した USB アダプターを PC に接続して下さい。

USB アダプターを認識するまで数分かかる場合もあります。 

正常に認識すると USB アダプターの LED が点滅します。 

ソフトウェア終了まで USB アダプターは抜かないでください。

Windows スタートメニューから "AirMagnet Survey" フォルダーの "Survey PRO" を実行します。 

インストール直後はライセンスがまだ指定されていませんので、下記のような画面が出ます。

[ OK ]をクリックして進めてください。

ライセンスの指定はここでダウンロードする方法と、MyAirMagnet から事前にライセンスをダウンロードして

ブラウズする方法が有ります。

ライセンスを事前にダウンロードしていない場合はライセンスファイル指定①(13 ページ)へ、

ライセンスをダウンロードした場合はライセンス指定②(16 ページ)へ進んでください。
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ライセンスファイル指定①

[ Download a license file from airmagnet.netscout.com. ]を選択し[ NEXT > ] をクリックします。 

[Tie AirMagnet software to a supported Wi-Fi adapter: ]を選択し[ NEXT > ] をクリックします。 
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MyAirmagnet で登録したシリアルナンバーとシリアルキーを入力します。 

[Adapters]で[Edimax AC1750 Wi-Fi USB Adapter]を選択します。MAC アドレスは自動で入力されます。 

登録した MAC アドレスと表示されている MAC アドレスが間違いないかお確かめください。 

間違いなければ[ NEXT > ] をクリックします。 

成功すると下記のような画面になります。[ Proceed ] をクリックして先へ進んでください。 
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以下の画面が表示された場合、Survey-PRO では[いいえ]を選択し次へ進んでください。 

旧 Survey-Express などで Planner モジュールなどのライセンスを追加する場合は[はい]を選択し上記と同じ 

手順でライセンスを追加して下さい。 

この後、ソフトウェアが起動します。 

18 ページへ 
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ライセンスファイル指定②

[ Browse for a license file from local machine.] を選択し [ NEXT > ] をクリックします。 

[ Browse... ] をクリックし、ライセンスファイルを保存したフォルダーを選択し、 

ライセンスファイルを選択してください。

[ Browse... ]をクリックしライセンスファイルを保存したフォルダを選択し 

ライセンスファイルを選択してください。

ライセンスファイル
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成功すると下記のような画面になります。[ Proceed ] をクリックして先へ進んでください。 

以下の画面が表示された場合、Survey-PRO では[いいえ]を選択し次へ進んでください。 

旧 Survey-Express などで Planner モジュールなどのライセンスを追加する場合は[はい]を選択し上記と同じ 

手順でライセンスを追加して下さい。 

この後、ソフトウェアが起動します。 

18 ページへ 
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ソフトウェアの起動中に下記のような画面が出た場合は

"Edimax AC1750 Wi-Fi USB Adapter"を選択してください。 

下記のようなメッセージが表示された場合、ライセンスに紐づけされた USB アダプターが 

接続されていないか、 デバイスドライバーが正常に機能していないことが考えられます。 

USB アダプターの抜き差しを繰り返すと Windows が正常に機能しない場合もあります。 

ゆっくりと時間をあけてから USB アダプターを挿入し、デバイスドライバーの準備が整うま

で、しばらくお待ち頂いた後にソフトウェアを起動してください。  

Windows の再起動などを行っても、デバイスドライバーが正常に機能しない場合は、  

USB アダプターの接続をご確認いただき正常と思われる場合は再度ドライバーの 

インストールを行ってください。

?
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② ソフトウェア起動から測定まで
Windows スタートメニューから "Survey PRO" (Surveyor) を実行します。 

※"No valid license..."などの表示が出る場合は前項の「ライセンスファイルの導入」をご参照ください。 

※USB アダプターを接続したまま Windows を起動した場合、AirMagnet ドライバーとの差替えがうまく

いかない場合があります。 その場合は USB アダプターを取り外し、再度接続してください。

※また、AirMagnet ソフトを終了せずに Windows をシャットダウンすると USB ドライバーの差し戻しが

中断し次回起動しなくなる場合があります。その場合は、ドライバーを削除し、再インストールしてく

ださい。

以下、一般的な測定を例に説明します。 

●最初に新規プロジェクトを作成します。

メニュータブの[File]を選択します。

サブメニューの[New Project]を選択します。
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開いたダイアログでプロジェクト名(Specify Project Name)を適宜入力し、一般的なオフィス・会議場など建物内

であれば[ Non GPS Project ]を選択し、保存するフォルダーを設定します。 

設定項目を再確認し間違いなければ [ NEXT> ] をクリックします。 

調査対象の間取り図などフロアーマップ図を用意してください。 

対応形式  .jpg .png .bmp .gif .dib .dwf .dwg .dxf .emf .vsd .wmf .vdx 

指定する縦横の長さは読み込むイメージファイルの余白部分を含む長さを実長に換算してください。 

縦 

Length 

横 Width 



日本語クイックガイド AirMagnet Survey-PRO Ver.10.0.0  ℂTOYO KEISOKUKI 2020 Aug. 

21 

読み込むフロアーマップのフォルダーとファイル名を指定し、イメージファイルの余白も含めた縦横の長さを 

実長に換算し入力します。"Unit of Measurement"がフィートになっている場合もありますので注意してください。 

一般的なオフィスなどでは"Open Space Office-Cubicles. etc."を選択します。 

"Signal Propagation Assessment"(信号伝搬予測値)は"Survey Planner Environment"を選択すると自動的に  

設定されますのでデフォルト値のままとする事をお勧めします。 

AP Default Power はご利用になる環境に合わせて 10mW などに設定しなおしてください。 

この値はシミュレーション機能で使用されます。 
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備考を付ける必要があれば入力してください。 

最後に [ Finish ] をクリックしてください。 

下記のようなウインドウが表示された場合はフロアーマップ図の縮尺を再調整するかを選択します。 

再調整する場合は [ はい ] を選択します。 後から  [ Measure Mode ] を使い再調整することもできます。 

フロアーマップ図の縮尺を再調整する方法 (上記で [ はい ]を選択した場合)

部屋の横幅など既知の２点を表示されたアイコンのヒ゜ンで指定し、その実長を次のウインドウで指定し 

[ Recalibrate ] をクリックし再調整します。 

(詳細は英文 UserGuide の" To recalibrate the scale of the floor plan:"の項をご参照ください。) 
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●日本地域チャンネルの設定を行います。

[ Configure ] を選択し、設定ダイアログを開きます。 

[ 802.11 ] タブを選択し "Japan" を選択し [ OK ] をクリックし一旦閉じます。 
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●スキャンチャンネルの設定

[Configure]を選択し、設定ダイアログを開きます。 

[ Scan ] のタブをクリックし、必要なチャンネルを選択します。 

必要であれば [ Scan Time ] を設定して、測定の間隔を設定します。デフォルトは 250ms です。 

設定を確認し、[ OK ]をクリックします。 
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●測定モードの設定 ([Passive] モード)

測定の方法は信号の強さを測定する Passive モードと、通信の速度を測定する Active モードがあり、ここでは

Passive モードを説明します。(Active モードは後述します。) 

ツールバーの[Survey] を選択します。

画面左下のウインドウで Survey モードを設定し、Passive(信号強度測定)を設定します。 

最初の測定では [Passive]、[2.4/5.0GHz]、[SSID]、[ANY]の設定とし、すべての AP を対象とすることをお勧め 

します。 2.4GH 帯のみや特定の SSID やチャンネルだけを選択して測定することも可能ですが、測定後の 

表示の際に SSID やチャンネルを選択することも可能です。 
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●ロギングモードの設定

フロアーマップ図周辺の空白部分を右クリックしてメニューを開きます。

[Sampling on Click Only]を選択します。このモードでは測定点毎にクリックして測定します。 

測定点と実際の図上の位置を合わせやすいため、この方法をお勧めします。 

右クリック 
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●サーベイ [Survey] の開始 (測定・記録)

最初の測定地点へ移動し [Start Survey]をクリックし測定を開始します。 

最初の測定地点へ移動し測定位置を示すアイコン   を図上の該当する位置に移動します。    

画面下の中央にスキャンしているチャンネル番号が表示されますので、チャンネル番号が 

１周するのを待って クリックし、次の測定点へ移動します。 

(緑のバーでチャンネルスキャンの進捗を表示します。) 

移動 → 測定 (チャンネルスキャン・クリック) → 移動と繰り返します。 

  測定中に[Pause]で一時停止することもできます。 

  もう一度クリックすると再開します。 

  この時点ではデータは保存されていませんので、 

  ご注意下さい。 
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測定を繰り返しすべての測定地点が終わったら    [Stop Survey]をクリックし停止します。 

停止するとダイアログが開きます。 

測定パスに名前を付け [ Save ]もしくは 

[ Save and Display ]をクリックして保存します。 

[ Save and Display ]を選択すると自動で Display モード 

になりヒートマップが表示されます。 

  or 

測定のヒント 

測定終了後に [ Display ] の[ Data Merge ] 

機能でデータを統合することもできます。 

部屋、通路など測定を小分けにしておけば、 

やり直しが必要な際などに、その部屋だけを

再測定し、必要なデータだけを選択して統合

することも出来ます。 

(詳細は英文 UserGuide の" Survey Project 

Window "の項をご参照ください。) 

右クリック 
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●ディスプレー [Display] モード

ツールタブの[Display]をクリックします。

測定したデータ(前頁の例で保存した"PassiveSurvey1")

を選択し測定結果を表示します。

画面左中のウインドウで表示するチャンネルや SSID を選択することもできます。 

目的外の SSID などを測定結果に含めず表示する必要がある場合などに便利です。 

画面右のスケールの下部付近に近づける

と手のマークに変わり、左クリックしながら

スライドするとアイコンが、しきい値を設定

し、しきい値以下をグレー表示にすることも

できます。

その他のアイコンの説明は「③メニュー操

作」をご参照ください。
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●レポート [Report]

[Display]で表示するデータを選択しておきます。 

 (前項を参照してください。) 

その状態で [Reports]を選択します。 

[File]→[Print]  (印刷) エクスポート

レポートの種類を左のウインドウから選択しダブルクリックします。

レポートの種類とパソコンの性能によっては数十分の時間が掛かることもあります。処理が終わると右の

ウインドウに表示されます。

編集 

レポート一覧から任意のレポートを右クリックし[Edit]をクリック

すると言語や表示項目の設定ができます。

印刷 

メニューの[File] [Print]と選択しプリンターを選択し印刷します。

エクスポート

右のウインドウの左上角のアイコン   をクリックすると 

Word や Excel などで出力する事が出来ます。 
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●プランナー [Planner]

仮想のアクセスポイントを配置して信号強度などを仮想で計算することが出来ます。 

Planner  をクリックしてプランナーモードにします。 

最初に  Create Wall をクリックし Concrete などの壁の種類を選び図上の壁をなぞります。 

    室内のパーティションなどは Plasterboard などを使います。 

  AP  をクリックして図の適当な場所に配置します。 

配置した AP を右クリックし Property を選択します。 

チャンネルや AP の名前、SSID、MAC Address などを

設定することが出来ます。

デフォルト設定は無指向性ですが、指向性アンテナなどを 

使っている場合は[Pattern]をクリックしてアンテナ 

パターンを選択します。 

下のスライダーで指向性の向きを変えることもできます。 

2.4GHz と 5 GHz の両方を設定します。 

使わない場合はチャンネル横の[Enable]を外します。 
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設定が終わったら Refresh をクリックしてヒートマップを表示します。 

[ Create Attenuation Area ]でエレベーターや機械室など減衰の多いエリアを設定することもできます。 

●アドバイザー機能（AP 配置の最適化）

 [Create Coverage Area ]でカバーしたいエリアを指定し  [Advisor]をクリックして AP

の配置を最適化することができます。AP などが勝手に変わってしまいますので事前にデータをセーブしておくこ

とをお勧めします。 

[Create AP Exclusion Area ]を指定すると AP を置くことができない場所を考慮して AP の配置

を最適化することができます。 

ここでシュミレーションした結果は [Display]モードで VirtualSurvey.svdx として表示されます。 

Passive Survey のデータとマージして AP 追加後の結果を予測することもできます。 
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●測定モードの設定 ([Active]モード )

ツールバーの [ Survey ] を選択します。

[Configure]を選択し設定ダイアログが開きます。 

[ 802.11 ] のタブを選択します。 

[New]をクリックしダイアログを表示します。 
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SSID を入力し[ OK ]をクリックします。 (アクセスする AP の SSID を正確に入力してください。) 

[Configure] ダイアログに戻ります。[ 802.11 ] のタブのまま、"Wireless network"のリストから入力した SSID を 

選択し[EDIT]をクリックして、 プロパティーダイアログを開きます。 

[セキュリティ] タブを選択し、"セキュリティの種類"と"暗号化の種類を AP に合わせて設定してください。 

設定方法は Windows と同様です。設定を確認し [ OK ] をクリックします。 

画面左下のウインドウで[Active(AP assoc.)] と[SSID]を選択し 

接続先を選択します。 

[ Start Survey ]をクリックすると、指定した AP に接続し測定を開始します。 

Passive モードと同様に、移動 - クリック(測定) - 移動を繰り返し測定します。 
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③ メニュー操作

●Top menu

[File] 

[Edit] 

画面の状態により、アンドゥ（実行した操作の取り消し）などの機能やヒートマップのコピーができます。 

New Project... 新たなプロジェクトを作成します。

Open Project... 既存プロジェクトファイルを開きます。

Save 作成したプロジェクトファイルを保存します。

Save Project As... 現在のプロジェクトを別名で保存します。

Close Project 現在のプロジェクトを閉じます。

Configure... 各種設定のダイアログを開きます。

New Plan... 新たなプランナープロジェクトを作成します。

Save Plan 現在のプランナープロジェクトを保存します。

Save Plan As... 現在のプランナープロジェクトを別名で保存し

ます。

Export to CAD 
CAD イメージ（.dwg）をインポートした場合は

AP と壁データとイメージをエクスポートするこ

とができます。

Antenna 
Manager... 

アンテナ・マネージャーダイアログを開きアン

テナ・パターン・テンプレートのカスタマイズや

修正をすることができます。

Planner 
Configuration... 

プランナー設定ダイアログを開き、プランナー

の表示のカスタマイズすることができます。

Planner Object 
Manager... 

プランナーオブジェクトマネージャーを開き、

壁やエリアタイプのリストを参照できます。

Recent Projects 直前に開いたプロジェクト開きます。

Multi Floor Planner マルチフロアー画面を開きます。

Exit Air Magnet Survey を終了します。 
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[View]

Zoom In サイトマップを拡大します。 ツールバー

の［Zoom In］と同様の機能です。

Zoom Out サイトマップを縮小します。 ツールバー

の［Zoom Out］と同様の機能です。

Zoom to Fit 
サイトマップをウインドウに合わせて拡

大・縮小します。ツールバーの［Zoom to
Fit］と同様の機能です。

Zoom to Actual 
Size 

実際の印刷サイズに合わせてサイトマッ

プを拡大・縮小します。 ツールバーの

［Actual Size］と同様の機能です。 

Set Zoom... Set Zoom ダイアログを開き拡大・縮小

の比率を指定します。

Show CAD 
Layers... 

CAD イメージに複数のレイアウトがある

場合は右クリックで選択します。

Toolbars and 
Docking Windows ツールバーに表示する機能を選択します

Show Rulers 目盛りを表示します。

Show Grids マップウインドウに格子を表示します。

Invert Legend 
Colors 凡例の色順を反転します。

Filter APs 
Data Filtering by AP ダイアログを開き、

AP を選択します。(英文 UserGuide の

"Filtered Data Files"をご参照ください。) 

Overlap 
重複するエリアを表示します。

Data Type で selected is 1st AP.が選択

されている必要があります。

Overall 全体的な表示にします。

Per Channel チャンネル毎に表示します。

Per SSID SSID 毎に表示します。 

Lock AP Location 
AP の位置をロックします。 
(英文 UserGuide の"Lock AP" の項を

ご参照ください。) 

Project Properties... プロジェクトのプロパティーウインドウを

開きます。

AP/Path Name 
Font... 

AP やパス名に表示される文字のフォント

を変更できます。

Measure Mode ２点間の距離を測ります。

Throughput 
Simulator 

スループットシュミレーターのウインドウを

開 き ま す 。 ( 英 文 UserGuide の

"Throughput Simulator"の項をご参照く

ださい。)

Refresh ヒートマップを再描画します。ツールバー

の[Refresh]と同じ機能です。
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●Planner Tool Bar

Project Wizard 新規のプロジェクトを作成します。

Open Project 既存のプロジェクトを開きます。

Save プロジェクトを保存します。

Configure Configuration (設定) ウインドウを開きます。 

Select カーソルでアイテムを選択できます。

Zoom In サイトマップを拡大します。

Zoom Out サイトマップを縮小します。

Zoom Fit サイトマップをウインドウに合わせて拡大・縮小します。

Actual Size 実際のサイズに合わせてサイトマップを拡大・縮小します。

Create AP サイトマップ上に新たな AP を配置します。

Measure Mode メジャーモードで距離を測ります。

Create Wall サイトマップ上に新たな壁を配置します。

Create Rectangular Attenuation 
Area 長方形の減衰エリアを作成します。

Create Arbitrary Attenuation Area 多角形の減衰エリアを作成します。

Create Elliptical Attenuation Area 円形の減衰エリアを作成することができます。

Create Rectangular Coverage 
Area 長方形のカバーエリアを作成します。 (Advisor 機能) 

Create Rectangular Excluded 
Area 長方形の AP 除外エリアを作成します。(Advisor 機能) 

Create Arbitrary Coverage Area 多角形のカバーエリアを作成します。(Advisor 機能) 

Create Arbitrary Excluded Area 多角形の AP 除外エリアを作成します。(Advisor 機能) 

Create Elliptical Coverage Area 円形のカバーエリアを作成します。(Advisor 機能) 

Create Elliptical Excluded Area 円形の AP 除外エリアを作成します。(Advisor 機能) 

Clear All Objects ダイアログで選択された AP や壁などのアイテムを削除します。 

Advisor Planner Advisor ツールを開きます。 

Refresh ヒートマップを描画します。

Overlap 重複するエリアを表示します。Display view で有効です。 

Filtering フィルターした Planner project の AP データを出力します。

Tools Signal と DHCP のツールダイアログが開きます。 

Calculator 電卓ツールが開きます。
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●Survey Tool Bar

Project Wizard 新規のプロジェクトを作成します。

Open Project 既存のプロジェクトを開きます。

Save プロジェクトを保存します。

Configuration Configuration (設定) ウインドウを開きます。 
GPS or Manual 
Mode 通常のサーベイモードと GPS を使ったサーベイモードを切り替えます。 

Print フロアープランを印刷します。 (Ctrl+P).

Measure Mode フロアープランの寸法を再調整します。

Toggle Outline ヒートマップの境界線を表示するかしないかを交互に設定します。

Start Survey サーベイを開始します。

Stop サーベイを停止します。

Pause サーベイを一旦停止し、もう一度クリックすると再開します。

Retract サーベイ開始後、今の測定を破棄し１つ前の測定地点に戻ります。表示が灰

色の時は使用できません。

Zoom In サイトマップを拡大します。 ツールバーの［Zoom In］と同様の機能です。

Zoom Out サイトマップを縮小します。 ツールバーの［Zoom Out］と同様の機能です。

Zoom Fit サイトマップをウインドウに合わせて拡大・縮小します。 ツールバーの［Zoom
Fit］と同様の機能です。

Zoom Actual Size 実際のサイズに合わせてサイトマップを拡大・縮小します。 ツールバーの

［Actual Size］と同様の機能です。 

Survey Zoom サイトマップのウインドウを大きくします。もう一度クリックすると戻ります。
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●Display Tool Bar

Project Wizard 新規のプロジェクトを作成します。

Open Project 既存のプロジェクトを開きます。

Save プロジェクトを保存します。

Configuration Configuration (設定) ウインドウを開きます。 

Print マップウインドウを印刷します。

Site Image イメージファイルをインポートします。

Import Path サーベイパスのサーベイデータをインポートします。

Import Survey 
Data サーベイデータ(.svd or .svdx)をインポートします。

Zoom In サイトマップを拡大します。 ツールバーの［Zoom In］と同様の機能です。

Zoom Out サイトマップを縮小します。 ツールバーの［Zoom Out］と同様の機能です。

Zoom Fit サイトマップをウインドウに合わせて拡大・縮小します。 ツールバーの［Zoom
Fit］と同様の機能です。

Actual Size 実際のサイズに合わせてサイトマップを拡大・縮小します。  ツールバーの

［Actual Size］と同様の機能です。 

Measure Mode メジャーモードで２点間の距離を測ります。

Toggle Outline ヒートマップの境界線を表示するかしないかを交互に設定します。

Create Comment ヒートマップ上にコメントを作成します。

Refresh ヒートマップを描画します。

Overlap 重複するエリアを表示します。Display view で有効です。 

Filtering フィルターした Planner project の AP データを出力します。

Tools Signal と DHCP のツールダイアログが開きます。 

Calculator 電卓ツールが開きます。
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●Configuration Dialog (設定)

Settings 

項目 説明

Ignore APs whose max discovered 
signal strength is less than 

信号強度が設定された値以下の AP を無視します。 
(0 の時は最強、 -100 は最弱です。). 

Hide ignored Access Point 無視した AP を表示しません。 

Auto logging data period ログデータを自動生成する時間間隔を秒で設定します。

デフォルトは 3 秒に 1 回です。

Beep when logging data 測定値を取り込むたびにビープ音が鳴ります。

ビープ音で測定が行なわれていることを示します。

Auto sampling through path 自動的に測定しサイトマップ上の測定点にマークしサーベイパス

に沿った青い点で示します。
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Sampling on click only 選択するとクリックしたときだけ測定しサイトマップ上の測定点にマ

ークします。 

Use maximum heatmap drawing 
resolution 

最高解像度でヒートマップの表示がスムーズになります。 

122 m のサイズ以下で有効です。  

Auto position APs with signal 
strength greater than 

設定されて値以下の値以上の AP を自動的に配置します。自動的

に配置します。  

Display MAC address only ベンダーID やカスタム名が表示せず、MAC アドレスのみで AP

を表示します。 

Prompt for refresh after AP location 
change AP の位置が変更されたときにリフレッシュの表示をします。 

Enable Survey Range Indicator サイトマップの測定地点に円形インジケータを有効にします。

Enable GPS port GPS ポートを有効にします。 

Hide APs below legend threshold in 
Bubble Window 

バブルウインドウに凡例のしきい値以下の AP が表示されなくなり

ます。 

Configure GPS GPS の設定を行います。. 

Channel Interference 干渉のダイアログを開き、干渉や雑音を計算する際に考慮される

AP の信号最小値を設定します。 

Spectrum Integration 
スペクトラムアナライザーの設定ウインドウが開きます。

AirMagnet Spectrum -XT が必要です。(英文 UserGuide の

"Working with Spectrum Analyzers"の項をご参照ください。)

PHY Data Rate Map PHY データレートマップのダイアログを開きます。 
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AP grouping 

項目 説明

Vendor ID デバイスのベンダー名を設定します。

Band 周波数帯を設定します。

MAC address order MAC アドレスが昇順(Ascending)か降順(Descending)かを設定しま

す。

MAC address hexdigit starting 
from MAC アドレスの開始アドレスを 0～F の 16 進数で設定します。 

Number of contiguous MAC 
address MAC アドレスが、いくつ連続するかを設定します。 
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Color 

項目 説明

Color Scheme 色の順番を選択します。

Outline Color 境界線の色を赤、緑、青の値を入力して変更するか［Select Color］をクリックして

色の設定ボックスから色を選択します。

Automatic contrast 
adjustment コントラストを自動調整します。

Granular color bar 
selection 選択すると凡例のカラーバーでしきい値の設定が微調整できます。

AP icon size AP アイコンの大きさを選択します。 
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802.11 Parameters 

[New]をクリックし新規の Profile を作成しダイアログで AP か SSID を入力します。 

リストの AP か SSID を選択し、[Edit]をクリックしセキュリティを設定します。

Country は[Japan]に設定してください。 
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Channel Scan

チャンネルリストのボックスをクリックしスキャンするチャンネルを選択します。

Select Country Cord Channels は設定した国の標準的なチャンネルが設定されます。 

Scan Time はチャンネルをスキャンする間隔を設定します。デフォルトは 250 ms です。 
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MapPoint 

Microsoft MapPoint の設定を選択します。アウトドアエリアで有効です。 
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Survey Profile 

[New]をクリックし新規プロファイルのダイアログを開き、 

"Create New Profile" を選択しプロファイル名を入力します。 

("Copy From" で別のプロファイルをコピーすることもできます。) 

[ OK ]をクリックし閉じます。 

作成した新規プロファイル名を選択し、[Note]欄にコメントを入力することもできます。 
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④ サポートサービスについて

サポートサービスをご契約いただくと、My AirMagnet にて下記のような事が可能になります。

● 最新版ソフトウェアー・ライセンスのダウンロード

● 最新版ドライバーのダウンロード

● ユーザーガイド・リリースノートなどのダウンロード

● MAC リセット

ソフトウェアのライセンスは USB アダプターなどの MAC アドレスと紐付けして管理されます。

ご登録の際は弊社取扱の USB アダプターの MAC アドレスを直接指定する方法を強くお勧めします。 

詳細は「My_AirMagnet のご案内」をご参照ください。 

更新のご契約について、又は上記資料がお手元にない場合は製品のシリアル番号と併せて下記へご連絡ください。

https://www.keisokuki-land.co.jp/netally/#contact 
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⑤ お問合せについて

ご不明なことがございましたら netally@keisokuki-land.co.jp までお問い合わせください。

お問い合わせの際はご質問に加えて下記情報もあわせてご連絡をお願い致します。 

●製品名

●シリアル番号

●バージョン番号

●お使いの USB アダプター名

●製品をインストールした or しようとしている OS 名と bit 数

シリアル番号は下記の様になります。

AirMagnet Survey の場合 A4018-XXXXXXXX 

AirMagnet WiFi Analyzer の場合 A1150-XXXXXXXX 

AirMagnet Spectrum XT の場合 B4070-XXXXXXXX 

X には数字が入ります。 

インストール時やソフトウェア操作中などにエラー表示がでた場合は画面キャプチャなどで保存していただき

メールに添付をお願い致します。
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よくあるお問い合わせ 

・Display で信号強度などの凡例が表示されない。

表示方法：View → Toolbars and Docking Windows → Legend をクリックし✓を入れる。 

・Display で表示しているヒートマップだけコピーしたい。

「Edit → Copy Heatmap Image をクリック」 もしくは 「図面上で右クリック → Copy をクリック」

・Display でピン   を立てた状態のヒートマップをコピーしたい。 

「図面上で右クリック → Copy Current View をクリック」 

・Measurement Details に表示されている情報をコピーしたい。

ここをクリック
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http://www.keisokuki-land.co.jp/support/netally/ 
NetAlly 日本総代理店 

東洋計測器株式会社
〒101-0021  

東京都千代田区外神田 1-3-12 

計測器ランドビル 

TEL: 03-3255-8026 

E-mail: netally@keisokuki-land.co.jp
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